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1. OVERVIEW 
1.1 Organization of User Manual 
The municipal solid waste (MSW) and agricultural sectors are significant sources of short-lived 
climate pollutant (SLCP) emissions, especially methane and black carbon. Anaerobic digestion 
(AD) is a natural process in which bacteria break down organic matter in an oxygen-free 
environment to form biogas and digestate. AD systems provide a variety of environmental and 
public health benefits that reduce SLCPs, divert organic waste, reduce odors, and destroy 
pathogens. The Global Methane Initiative (GMI) developed the AD Screening Tool to support 
biogas developers in conducting preliminary feasibility assessments of the volume of biogas 
their AD system could generate based on available waste streams. The tool will provide a first-
order estimate of the potential quantity of gas and digestate that could be produced annually by 
a given waste stream, as well as estimates of emissions reductions from the project.  
 
Additionally, the tool provides users with inputs for the EPA’s Organics Economics (OrganEcs) 
tool based on the digester characteristics input here. The OrganEcs tool can be used to 
estimate the costs associated with anaerobic digestion and organic waste management 
projects.1 
 
This manual contains: 

• An overview of the tool and its design (Section 1),  
• Detailed documentation on how to use the tool and interpret results (Section 2), 
• Explanation of the tool’s assumptions, methodology, and limitations (Section 3), and 
• A list of sources uses to develop this user manual (Section 4) 

1.2 Organization of Spreadsheet Tool 
AD Screening Tool’s tabs are categorized in five sections (outline below).  

• Brown tabs provide instructions, notes, assumptions, default values references, and 
additional information.  

• Blue tabs require users to enter data. 
• Black tabs provide several tables and charts that summarize the tool's outputs.  
• Yellow tabs provide information on assumptions and defaults.  
• Grey tabs provide more detailed information and calculations used to run the analysis. 

 
  

 
1 More information about OrganEcs – Anaerobic Digestion v3.0 can be found at: 
https://www.globalmethane.org/resources/details.aspx?resourceid=5175  

https://www.globalmethane.org/resources/details.aspx?resourceid=5175
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The following lists provide an overview of information covered under each tab:
 
Basic Tool Information (Brown Tabs) 
AD ST History 
1. Introduction 
2. Instructions 
14. References 
15. Help  
16. Methodology 
 
Data Inputs (Blue Tabs) 
3. Digester Inputs 
4. Emissions Inputs 
 

Outputs (Black Tabs) 
5. Annual Summary 
6. Biogas Production 
7. Digestate Production 
8. Estimated Emissions Reductions 

 
Assumptions and Defaults (Yellow Tabs) 
9. Feedstock Characteristics  
10. Feedstock Toxicity Info  
11. Calibration Factors 
12. OrganEcs Input Sheet 
13. MCF 
 
Detailed Information and Calculations 
(Grey Tabs) 
17. Manure Related Reductions 
18. Other Wastes Reductions 
19. Storage 
20. Methane Gen.& Utilization  
21. Electricity Use 
22. Flaring & Leakage 

1.3 Entering Data 
When you open the tool, you will be prompted to enable the tool’s macros. You must enable 
macros for the tool to function correctly. You will either be prompted with a pop-up upon opening 
the tool, or a yellow warning bar will appear at the top of the program asking you to “Enable 
Content." If you did not choose to enable macros, close the tool and reopen it, and you will have 
the option again to enable macros. 
 
Enter data for your current or proposed organic waste feedstocks and management information 
into all blue (█) cells. Some of the blue cells contain helpful hints and definitions that will appear 
when you click on them.  
 
Yellow (█) cells are default values that are automatically provided. You can change these 
values if you have local data available. You can reset any user-entered data to original default 
values by clicking on the “Reset Default Values” buttons provided on each data input page.  
 
The light grey (█) cells, except for those in columns labeled “source” or “notes,” contain 
calculated values that cannot be edited.  
 
Specific instructions for entering data into each tab can be found in the sections below. 
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2. USING THE AD SCREENING TOOL: TAB-BY-
TAB GUIDE 
2.1 Basic Information 

2.1.1 Cover 

The Cover tab includes attribution and contact information.  

2.1.2 Introduction 

The Introduction tab contains a brief description of the AD Screening Tool and how it can be 
used.  

2.1.3 Instructions 

The Instructions tab describes how to use the tool, providing general guidance for the data entry 
and output tabs.  
 

• Macros in the Excel tool automate several functions in the tool, including the “Reset 
Default Value” buttons found on the input tabs. Macro functions automate processes in 
Excel files, but most organizations do not automatically allow macros to run due to 
security risks. Enable macros for the tool to ensure that the tool’s automated functions 
run while in use. For more information on Enabling or Disabling Macros, see Microsoft 
Support’s Help Page: https://support.microsoft.com/en-us/office/enable-or-disable-
macros-in-office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6.  

o Users must "Enable Macros." Users will be prompted to do so when opening the 
workbook.  

                     
Figure 1: Enabling Macros after opening the AD Screening Tool 

o If not prompted to enable macros, the user can enable macros at File → 
Options> Trust Center →Trust Center Settings.  

o Use the following instructions to enable macros only for the duration that the file 
is open.  
 When you close the file, and then reopen it, the warning appears again. 
 Click the File tab. 

https://support.microsoft.com/en-us/office/enable-or-disable-macros-in-office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
https://support.microsoft.com/en-us/office/enable-or-disable-macros-in-office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6


    

AD Screening Tool v2.2 March 2022 5 

 In the Security Warning area, click Enable Content. 
 Select Advanced Options. 
 In the Microsoft Office Security Options dialog box, click Enable content 

for this session for each macro. 

o  
Figure 2: Enabling Macros through the Excel Security Settings 

 
• Enter data into the blue (█) cells on the “3-Digester Inputs" tab. Users must enter data in 

every cell that is shaded blue (█). This information will be used to generate biogas and 
digestate estimates.  

o For every data point the user enters, the user should make a note of the 
information source or any assumptions made. The tool provides space for the 
users to make annotations.  

• There are several yellow (█) cells on the “3-Digester Inputs" tab. These cells represent 
default values or assumptions. Users are not required to change these values but are 
encouraged to do so if local data are available. 

 
Tips 

• The tool provides suggestions and guidance for several of the blue (█) data fields. 
Users will see the guidance when they click the cells. Work through data entry with the 
User Manual to ensure data are entered correctly.  

• Some cells have automatic validity checks. If a user enters an incorrect value or does 
not choose a valid selection, the automatic validity cell will turn red, and an error 
message will appear. Please correct the error before continuing. 
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2.2 User Inputs  
2.2.1 Digester Inputs 

This tab collects generation project information including the project name, location, AD reactor 
type and temperature, and if the system will include dewatering equipment.2  
 
The image below shows the required blue (█) cells on the “3-Digester Inputs" tab, filled out with 
sample data from a case study of Bar-Way Farms in Deerfield, MA.  

Minimum Data Requirements  

The following data requirements on the “3-Digester Inputs” tab are the minimum data needed to 
produce the annual biogas and digestate production estimates on the “5-Annual Summary,” “6-
Biogas Production,” and “7-Digestate Production” tabs. You can run the analysis using only the 
following inputs on the “3-Digester Inputs” tab: 

• Project Name 
• Project City/Municipality  
• Project Country  
• Planned AD type: wet or dry  
• Will the system installation include dewatering equipment? 

o If yes, what is the solid capture efficiency (%)  
• Feedstock Type and Amount  

o Note: Refer to United States Dept. of Agriculture (USDA). “Chapter 4: Agricultural 
Waste Characteristics.” In Agricultural Waste Management Field Handbook. 
Washington D.C.: USDA, 2008 for assistance estimating AD feedstock amounts 
from livestock. 

 
Note: Additional data entered on the “4-Emissions Inputs” tab will populate results on the “8-
Emission Reductions” tab but is not required to populate the “5-Annual Summary,” “6-Biogas 
Production,” and “7-Digestate Production” tabs. 

 
2 Dewatering equipment reduces the water content of the biosolids post-digestions to reduce the hauling 
cost. For more information: Review the Water Environment Federation’s Anaerobic Digestion 
Fundamentals Factsheet. 

https://directives.sc.egov.usda.gov/OpenNonWebContent.aspx?content=31475.wba
https://directives.sc.egov.usda.gov/OpenNonWebContent.aspx?content=31475.wba
https://directives.sc.egov.usda.gov/OpenNonWebContent.aspx?content=31475.wba
https://www.wef.org/globalassets/assets-wef/direct-download-library/public/03---resources/wsec-2017-fs-002-mrrdc-anaerobic-digestion-fundamentals-fact-sheet.pdf
https://www.wef.org/globalassets/assets-wef/direct-download-library/public/03---resources/wsec-2017-fs-002-mrrdc-anaerobic-digestion-fundamentals-fact-sheet.pdf
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Data Entry 

   
Figure 3: Digester Inputs Data Entry Table with Sample Data 

Write in your project name, city/municipality, and country name.  
 
In the General Information and Questions table:  

• Planned AD system is set to a default value of Wet. If you choose to change from the 
default value, select “Dry” from the dropdown list. When you click on the cell to choose 
Wet or Dry from the dropdown list, a note will appear defining the conditions of a Wet 
and Dry system.  

• Reactor temperature is set to a default value of Mesophilic. If you choose to change from 
the default value, select another option from the dropdown list.  

• Select Yes or No to indicate if the system will include dewatering equipment   
• If you selected Yes to indicate that the project will include dewatering equipment, enter a 

whole number percentage for the solid capture efficiency of the system.  
 
In the Feedstock table, you will add in all organic feedstocks that will feed the AD system.  
 
1) In the Feedstock List column, select from either General or Specific in the drop-down list.  

a) This selection will change the list of feedstocks in the Feedstock Type column.  
b) Selecting General from the Feedstock List column will show a general list of the more 

common feedstock categories in the Feedstock Type column to streamline data entry.  
c) Selecting specific from the Feedstock List will show the full list of all feedstock options in 

the Feedstock Type column. 
2) After choosing from the General or Specific Feedstock list, select the Feedstock Type from 

the pre-set drop-down list.  
3) Enter a numerical value for the Feedstock Total and select the appropriate units. 
4) Optional: Write-in additional notes in the User Notes column.  
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Summary Information  

• AD Waste Substrate Summary Information (B34:F40) – This table shows the 
calculated moisture content, total solids, volatile solids, inserts or ash, current biogas 
production, and current digestate production based on the feedstock inputs. 

• Bioreactor Design Summary Information (B41:F44) – This table shows the solid 
retention time, waste stream carbon to nitrogen (C:N) ratio, and the recommended 
bioreactor type.  

• Science & Error Check (B45:F47) – This table analyzes the substrate results to 
indicate if the reactor type has the optimal mix of total solids based on the system design 
(Yes or No) in cell D46. In cell D47, the table indicates if the C:N ratio is optimal for AD 
(Yes or No). Note that AD projects can be still be viable even if these checks indicate 
that the system does not have the optimal mix of total solids or the optimal C:N ratio.  

Default Values on the Digester Inputs tab 

• Feedstock Characteristics (F16:O31) – Default values are set for moisture content, 
total solids, volatile solids, inert materials and ash, nitrogen content, carbon content, 
proteins, fats, and sugars and starches. You can override the default percentages with 
site-specific information. To reset any of the fields, click on the “Reset” buttons, located 
below each column.  

• Biogas Composition (C58:C65) – Default information on the recommended 
composition of the planned AD system substrate. You can override the default values by 
writing in alternate values. To reset any of the fields, click on the “Reset Gas 
Composition” button to the right of the table.  

• Other Default Assumptions (C68:C72) – Default information on the recommended 
composition of the planned AD system substrate. You can override the default values by 
writing in alternate values. To reset any of the fields, click on the “Reset Gas 
Composition” button to the right of the table. 

2.2.2 Emissions Inputs 

Data entered on the “4-Emissions Inputs” tab will populate results on the “8-Emission 
Reductions” tab to calculate the annual projected net emissions reductions from the AD project. 
Entering data on the Emissions Inputs tab is not required to estimate biogas production, but it is 
an optional feature that will calculate the methane emission reductions associated with your 
project..  

Waste Management and Storage 

 
Figure 4: Waste Management and Storage Data Entry Table with Sample Data 
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• Select a previous management system for manure from the drop-down list. This 
indicates the type of system used for manure management before the development of 
the AD system. 

• Select a previous management system for other waste from the drop-down list. This 
indicates the type of system used for the management of other waste streams before the 
development of the AD system. 

• Write in the reporting period temperature and select the temperature units (Celsius or 
Fahrenheit) from the drop-down list. 

• Select Yes or No to indicate if the facility temporarily stores organic feedstocks on-site. 
o If yes, select a storage system from the drop-down list.  
o If yes, enter a whole number value for the total days the waste was stored 

annually. 

Methane Utilization  

 
Figure 5: Methane Utilization Data Entry Table  

• If methane is utilized onsite, enter the whole number percentage of methane utilized 
onsite (for example, to enter 85 percent type “85” instead of “0.85”). The tool assumes 
that 90 percent of methane will be utilized onsite, with the remaining 10 percent sent to 
flare, based on EPA’s eGRID database. Ideally, projects utilizing methane onsite will 
have a utilization percent higher than 90 percent or even reaching 100 percent. To 
override the default value, enter a whole number to replace 90 in cell B22.  

o If methane is not utilized onsite, enter 0. 
• Select the combustion process from the drop-down list. 

o If methane is not utilized onsite, select “none.” 

Flaring  

  
Figure 6: Flaring Data Entry Table  

• The measured methane sent to flare is automatically calculated using the percentage 
entered for methane utilization above in cell B22. The sum of methane utilization and 
methane sent to flare should equal 100 percent. 

• Select the flare type from the drop-down list.  
• Select Yes or No to use default combustion process efficiency.  

o If you select “No,” enter the combustion process efficiency.  

https://www.epa.gov/egrid
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o If you enter your own grid data but wish to return to the default values, click the 
“Reset Flaring Defaults” button to the right of the table.  

Electricity Consumption and Generation  

 
 
Figure 7: Electricity Consumption and Generation Data Entry Table with Sample Data 

• Select the country from the drop-down list.  
• Select Yes or No to indicate is electricity is generated and used onsite. 

o If you select “No,” cells B37:B39 will turn grey. Do not enter data into the grey 
cells.  

o If you select “Yes,” enter a numerical value for the amount of kilowatt-hours 
(kWh) consumed per day. 

o If you select “Yes,” the project biogas CO2 and CO4 emissions factor defaults will 
automatically populate cells B38 and B39. 

• Enter a numerical value in kWh per day to indicate how much electricity is used from the 
electricity grid.  

• Select Yes or No to indicate if the tool should use default grid data.  
o If you select “No,” enter the grid emissions rate and grid gross loss percentage. 
o If you enter your own grid data but wish to return to the default values, click the 

“Reset Electricity Consumption and Generation Defaults” button to the right of the 
table.  

Leakage  

 
Figure 8: Leakage Data Entry Table with Sample Data 

• Some degree of leakage occurs from all AD systems. Leakage is the methane released 
through pipes, equipment, and other apparatuses used to generate biogas. This tool 
uses the UNFCCC CDM (2017) default leakage rate of 10 percent of methane 
production, but the user may override the recommended defaults by typing in a whole 
number percentage in cell B50. 
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2.3 Outputs 
2.3.1 Annual Summary 

The Annual Summary tab estimates the planned AD system’s annual digestate and biogas 
production and options for energy recovery. The results are a first-order estimate, the actual AD 
production could vary based on waste characteristics, system design, and system operation.  
 
The biogas production estimates are provided as a range of likely values (low and high), as well 
as the theoretical maximum potential. Actual biogas production values can vary considerably, 
based on differences in the design and operations of AD systems. It is expected that the biogas 
production from the selected feedstocks will be within the low and high estimated values, but 
they could be as high as the theoretical maximum potential.  
 
The biogas production estimates are calculated using calibration factors, found on the 
Calibration Factors tab. EPA developed the calibration factors by comparing the results of the 
AD Screening Tool to measured biogas production data collected by EPA from more than 
operational 100 AD systems. For each operational system, EPA developed a ratio of the 
measured data to the modeled values from the AD Screening Tool. The calibration factors 
represent the 25th and 75th percentile values of the ratio between measured and modeled data. 
The theoretical maximum potential values are the uncalibrated estimates generated by the AD 
Screening Tool. Biogas production can be viewed in m3/year or standard cubic feet per year 
(scf/year). 
 
The digestate production estimates the total non-biodegradable solids, remaining volatile solids, 
digester solids, dry sludge, and liquid effluent. If you indicated that the AD system would not 
install dewatering equipment, the dry sludge and liquid effluent values will appear as “N/A”.  
 
The tool provides energy recovery option estimates as examples of the types of energy that 
could be produced from the biogas. These energy options are mutually exclusive, meaning that 
the plant will not be capable of producing two or more of the estimates shown.  
 
The final table provides an overview of bioreactor toxicity to indicate waste stream inhibitors that 
could impact at AD project. Each feedstock input will appear in the table. This table is provided 
as a reference, to indicate potential sources of toxicity commonly associated with each selected 
feedstock.  

2.3.2 Biogas Production 

This tab shows the total estimated biogas and methane produced daily based on the feedstock 
inputs entered. The biogas and methane production estimates are based on the average of the 
low and high production values calculated using the aforementioned calibration factors. The tab 
includes a bar chart showing biogas production by feedstock type per retention period. The 
table shows the average biogas production breakdown by feedstock type.  
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2.3.3 Digestate Production  

This tab shows the total estimated digestate produced daily based on the feedstock inputs 
entered. The tab includes a bar chart showing digestate production by feedstock type per 
retention period. The table shows the digestate production breakdown by feedstock type.  

2.3.4 Emission Reductions 

This tab shows the estimated baseline emission reductions, project emission reductions , and 
net emissions reductions from the AD system. 
 
The results are based on the SLCP global warming potentials table at the bottom of the tab, 
which can be updated with alternative values. To reset default values, select the reset button to 
the right of the table.  

 
Figure 9: Global Warming Potential Default Values 

2.4 Default Values and Assumptions 
The AD Screening Tool includes several tabs with the default values and assumptions used to 
calculate the biogas and digestate production and the methane emission reductions.  

2.4.1 Feedstock Characteristics  

This tab shows the default feedstock characteristics and the data sources, including the 
moisture content, total and volatile solids, methane yield, and bulk density. This table is used to 
populate the default values for each feedstock on the Digester Inputs tab.  

2.4.2 Feedstock Toxicity  

This tab shows the potential inhibitors to the AD system by feedstock type, including potential 
sources of toxicity commonly associated with each feedstock. This table is used to populate the 
possible inhibitors table on the Annual Summary tab.  

2.4.3 Calibration Factors 

This tab lists the calibration factors developed using actual observation data from an AD project. 
These calibration factors are used to determine the low, high, and theoretical maximum biogas 
output on the Annual Summary tab. The development of the calibration factors is discussed in 
section 2.3.1. 

2.4.4 OrganEcs Input  

This tab shows inputs that can be used in EPA’s Organics Economics (OrganEcs) tool to 
estimate costs associated with an organic waste management project. OrganEcs requires 
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inputs on the characteristics of the waste stream for the waste management project. This tab 
allows you to copy the results of AD Screening Tool directly into the input for the OrganEcs 
Anaerobic Digestion v3.0 tool.3  

2.4.5 Methane Conversion Factors (MCF) 

This tab shows the methane conversion factors or the percentage of a waste’s maximum 
methane production capacity achieved during waste management and disposal. The values are 
used to calculate baseline emissions from manure on the Manure Related Emissions tab, 
baseline emissions from other wastes on the Other Wastes Reduction tab, as well as temporary 
storage emissions on the Storage tab. 

2.5 Tool Information 
2.5.1 References  

This tab lists call data sources used to create the tool, with one citation per row. 

2.5.2 Help 

This tab provides the email address for the tool developers and a link to the GMI website for 
additional information.  

2.5.3 Methodology 

This tab provides an overview of the methodology used in the tool. 
 

2.6 Calculations 
The following tabs include the background calculations to estimate the biogas and digestate 
production and methane emission reductions, using the selected feedstocks. 

2.6.1 Manure Related Reductions 

This tab calculates the baseline emissions from manure using the Digester Inputs data entry 
table and the MCF values on the MCF tab. 

2.6.2 Other Wastes Reductions 

This tab calculates the baseline emissions from co-digested waste using the Digester Inputs 
data entry table and the MCF values on the MCF tab. 

2.6.3 Storage 

This tab calculates the temporary storage emissions associated with the feedstocks entered on 
the Digester Inputs tab and the MCF values on the MCF tab. 

 
3 Learn more about the OrganEcs tool at: 
https://www.globalmethane.org/resources/details.aspx?resourceid=5175   

https://www.globalmethane.org/resources/details.aspx?resourceid=5175
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2.6.4 Methane Generation and Utilization 

This tab shows the methane generation and utilization default values that correspond with the 
methane utilization selection on the Emissions Input tab. 

2.6.5 Electricity Use  

This tab shows the electricity generation and use default values used on the Emissions Input 
tab. 

2.6.6 Flaring and Leakage 

This tab shows the flaring and leakage default values used on the Emissions Input tab. 

3. LIMITATIONS 
The AD Screening Tool provides a first-order estimate of the potential quantity of gas and 
digestate that could be produced annually by a given waste stream, as well as estimates of 
methane emissions reductions from the project.  
 
This tool is intended as a pre-feasibility screening tool, to help users understand the 
approximate amount of biogas that can be generated from various organic waste feedstocks. 
The biogas production estimates from the tool are based on feedstock characteristics from 
published literature, which are listed on the References tab in the tool. However, many 
feedstocks, particularly composite feedstocks such as mixed food waste, can vary widely in their 
biogas production potential.  
 
The tool has been calibrated against real-world data to ensure that the biogas production values 
are as accurate as possible. However, the actual biogas production of an operational AD 
system will depend on the waste characteristics, reactor temperature, system design limitations, 
and daily operations. 
 
For these reasons, it is necessary to conduct additional modeling and analysis using site-
specific data before initiating development of an AD system.  
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